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All data for the exercises can be downloaded here:
https://tinyurl.com/SPIFArcGIS-ExerciseData

Save the “ExerciseData” folder in the “ArcGIS” folder that
was created upon installation of the software. Do not
change the names of any of the folders or file names.

Please contact SPIF at spif@astro.cornell.edu with any
questions or issues.
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Introduction to ArcGIS

Exercise 1A: Working in ArcCatalog

Estimated time: 15 minutes

Exercise 1B: Working in ArcMap

Estimated time: 25 minutes



Chapter 1: Workspace basics

Introduction

In this exercise you will learn the basics of how ArcCatalog™ and ArcMap™, which are two of the applications
in the ArcGIS® Desktop suite of software. In ArcCatalog you will see how to create databases, organize data,
preview data, and get information about data (metadata). In ArcMap you will see how a map document is
structured and how to navigate through map elements in both Data View and Layout View. You will also see
how to perform certain functions of ArcCatalog from within ArcMap by using the Catalog Window.

Objectives

Create a geodatabase in ArcCatalog

Explore data using previews and metadata in ArcCatalog
Access ArcCatalog from within ArcMap

Load a map document

Explore the map document structure in Data View

YV V.V V V V

Explore the map document structure in Layout View
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Geodatabase
Feature Dataset
Metadata

Map Document
Data Frame
Layer

Data View
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Layout View



Introduction to ArcGIS

What is ArcGIS?

> GIS stands for Geographic Information Systems

> Tool used for mapping; 2D and 3D Modeling; Geographic Analysis; Storage, Organization, and Processing of ANY
spatial data, or data related to location; etc.

> Integrates spatially related information in the form of layers

Water Pipes

Earthquake / Hazard Maps

Streets and Land Parcels

Gas Line

Geology / Structural / Mineral

Satellite Imagery

GIS map of Mars showing 64 layers, many
of which are PDS releases




Components of ArcGIS Desktop
> ArcMap
» Where most of the work is done
> Used to visualize, explore, and analyze data
> ArcCatalog
> Similar to Windows Explorer or Mac Finder, but specifically designed for ArcGIS
> Used to find, explore, and organize data
> ArcToolbox
» Contains (extra) tools for organizing, displaying, and analyzing data
» Custom tools can be created using Python
» Others
» ArcGlobe and ArcScene: used for 3D visualization

> Model Builder: used to create customized tools and multiple iteration workflows

Typical ArcGIS Workflow

ArcCatalog
find & explore data
create & organize database

!

ArcMap
ArcCatalog - (Data View) e ArcToolbox

organize visualize analyze
view metadata create & edit

symbolize

!

ArcMap
(Layout View)

create publishable map product




Final Goal: Analysis Results and Publishable Map
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Types of Data
» Vector
> Geometric features such as points, lines, and polygons

> Stores geometry, spatial data, and unlimited additional information for each feature (numerical, descrip-
tive, images, hyperlinks)

> Image files, or other similar data

> Array of cells (pixels), each with location in the array and a single numerical value, possibly spatial data
(coordinate systems)

» Contains information for how to display data

» Order of layers, symbols and colors, labels, projections

Common File Types (More Information in Quick Reference Guide and Appendix)
» Geodatabase (*.gdb)

> ArcGlIS file structure for storing, organizing, and sharing data with other ArcGIS users
> Image File, Raster

» Common: TIFF (regular or GeoTIFF), JPEG, JPG2, PNG, BMP, GIF, etc.

> Dataset specific: SAR, SRTM, DEM, DOQ, LAS, many more
» Shapefile (*.shp), Feature Class

> Stores spatial and geometric data for features
> Map Document (*.mxd), Layer (*.lyr)

> Stores information for how to display data

» Does NOT store any source data
> Packages (*.Ipk, *.mpk)

> Stores both display instructions AND source data

» Good for sharing with other ArcGIS users who do not have access to your geodatabase

Coordinate Systems and Projections

> Anytime you are modeling a curved surface (planet, moon, etc.) as a flat surface (map displayed on paper or a
screen), all cartographic issues are present and must be considered!

> Geographic Coordinate Systems
> Longitude and latitude measured from a planet’s center

> Requires a defined prime meridian



> ArcMap will display in angular coordinates
» Projected Coordinate Systems
> Takes latitude and longitude and datum and converts it to a flat array
> Points are assigned orthogonal positions with a defined origin
> ArcMap will display in linear units
» Measurements
> Distortions are UNAVOIDABLE; all measurements are APPROXIMATIONS

> If data only have a geographic coordinate system, geometric measurements will be inaccurate or not use-
ful (lengths and areas in degrees)

> If data are projected:
> Planar measurements assume the surface is truly flat

» Geodesic measurements assume a curved shape based on the datum

Tips, Tricks, and Quirks

» ArcGIS hates spaces and special characters, so file and folder names must be alphanumeric with no spaces, BUT, ali-
ases (nicknames, shortcuts and labels) can have any characters

» ArcCatalog within ArcMap is not great at refreshing itself, and sometimes even telling it to refresh doesn’t work

> It is not uncommon to get the “Not Responding” error message across the top of the window in ArcGIS, however,
unlike most programs, ArcGlIS tends to recover on its own

> Geodatabases: feature classes must be INSIDE, shapefiles must be OUTSIDE
> Copying and pasting features doesn’t always work well, but there are workarounds
> There are usually multiple ways of doing things (menu, button, keyboard shortcut, etc.)

> Sometimes a tool will appear to run but the output is absent or junk, despite not getting an error message (check
the Result window)

> Accessing ArcCatalog from within ArcMap has limitations, since file structures in use by ArcMap cannot be altered in
the Catalog window

> If the data used in a layer is edited in one ArcMap session, the results are reflected in all other ArcMap documents
where that data is used

> Once the projection of a data frame is set, data can be added as layers even if they do not share that projection
(ArcMap will “project on the fly” for the sake of display), but working with these layers without re-projecting them can
give error messages

> Even within a given coordinate system, there can be inconsistencies in display, such as longitude ranges of -180° to
180° vs. 0° to 360°



Additional Resources

ESRI Training: www.esri.com/training/

Instructor-lead courses: ArcGlIS 3, Image Analysis

Web Courses (requires maintenance subscription)

Tutorials, Videos, Training Seminars (free)

Getting To Know ArcGIS Desktop (ESRI book, covers most topics of instructor-lead courses ArcGIS 1 and 2)
Planetary Usage Support: astrogeology.usgs.gov/facilities/mrctr

Mastering ArcGIS, by M. Price (workbook-style reference, with links to instructional videos)

V V V V V V VYV VY

Lining Up Data in ArcGIS

10



Chapter 1: Workspace basics

Exercise 1A: Working in ArcCatalog

Estimated Time: 15 minutes

Main components of the ArcCatalog window

.‘jl ArcCatalog - C:\Users\Public\Documents\ArcGIS Workshop LPSC 2019 Exercises Data\lmagery\THEMIS_IR_100m\GusevBasemap.tif = X

File Edit View Go Geoprocessing Customize Windows Help

ialea BB x| HQREEO R, QTG - @8
E\C:\Users\Puinc\Documents\thlS Workshop LPSC 2019 Exercises Data\Imagery\THEMIS_IR_10{ Iﬁ
BBB
Catalog Tree ® X | Contents Preview Description
=] Folder Connections
e
B E3J C:AUsers\Public\Documents\ArcGIS Workshc
Chapter 1
E3 Chapter2
Chapter 3
B3 Chapter4
Chapter 5
Crater Data
B B Imagery
MOLA 463m
© E3 THEMIS_IR_100m
@ GusevBasemap.tif
B8 Gusev_IRDay_100m.tif
E Slope.tif
ﬁ Toolboxes
@ Database Servers
3 Database Connections
@l GIS Servers
My Hosted Services
Ready-To-Use Services

A. The Catalog Tree shows files on drive similar to explorer, but recognizes geodatabase elements.

B. The tabs show different aspects of the data. Contents will show you files and ArcMap elements within a selected

workspace (folder or geodatabase). Preview and Description show you information about a specific file or ele-
ment.

C. The Preview option menu selects whether to view the file or element visually or quantitatively.

Step 1: Create a geodatabase

>
>

A\

Y

Start ArcCatalog.

Click Connect To Folder £% in the toolbar near the top of the window.

Building a folder connection makes it easier to access the data you will need for this exercise. This can also be done
by right-clicking on Folder Connections and clicking Connect To Folder.

Navigate to where you have stored the data and highlight the Chapterl folder.

Click OK.

Notice how the folder name in the Catalog Tree shows the folder pathway.

Make the connection easier to read by right-clicking on the folder name and selecting Rename.

Name it Chapter 1.

Note that since this is an alias, it is acceptable to use a space in the name.

11



Exercise 1A: Working in ArcCatalog Chapter 1: Workspace basics

> Inthe Catalog Tree, expand the Chapter 1 folder.
» Right-click on the Exercisela folder in the Catalog Tree, and from New select File Geodatabase.

» Rename the new file geodatabase GusevCrater.

Step 2: Create a feature dataset within a geodatabase.

> Right-click on the GusevCrater geodatabase in the Catalog Tree, and under New select Feature Dataset.
> Nameit Craters, and click Next.

» Click on Add Coordinate System €7 and select Import.

> Navigate to the Maps folder in the Chapterl folder, select GusevBasemap, and click Add.

> Click Next, then Next again, and then Finish.

MNew Feature Dataset X

Choose the coordinate system that will be used for XY coordinates in this data.
Add Coordinate

Geographic coordinate systems use latitude and longitude coordinates on a spherical mode] System

of the earth's surface. Projected coordinate systems use a mathematical conversion
transform latitude and longitude coordinates to a two-dimensional linear system.

| | MECE N R ¢

B Bg Favorites

@ Equirectangular_Mars

€} SimpleCylindrical_Mars
ES Geographic Coordinate Systems
Projected Coordinate Systems

Current coordinate sysbem:
<Unknown> A

< Back || Next > | | Cancel

Setting the coordinate system for a dataset

12



Exercise 1A: Working in ArcCatalog Chapter 1: Workspace basics

Step 3: Explore an existing geodatabase

>

Y YV V V V V

vV VY

In the Catalog Tree, click on the GusevRegion geodatabase in the Exercisela folder to view its contents in the
Contents tab to the right.

Double-click to expand the feature dataset Craters.

Click once on CraterRims.

Click the Preview tab to see what this feature will look like on a map.

Change the Preview option at the bottom from Geography to Table to see the data stored within the feature.

Click the Description tab.

This shows you the metadata for this feature.

Scroll through to explore the metadata.

This metadata can be updated by clicking on the Edit button under the Description tab.

In the Catalog Tree, expand the Maps folder in the Chapter 1 folder and select GusevBasemap.
Go back to the Preview tab.

Pan &', Zoom in ®, and Zoom out =, to examine the raster.

If you zoom in too far and are lost, use Full Extent @ to return to a full view of the data frame.

Close ArcCatalog.

13



Exercise 1B: Working in ArcMap

Estimated Time: 25 minutes

Main components of the ArcMap window

Chapter 1: Workspace basics

[A]@ usevpracticet.mod - Archap =8 = |
File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help
NREA L @@ x| O | db-| 125000 ~|| 32| B G B @) | e Load Objects.. |
Pliaa@oiities K]0/ @i@ifag 0I&E,
[able Of Contents % ] ~ [Gatalog 2 x
Eles8lE e o @8]k
[E][ & = Gusev Region B | Location: '@ practicer.mxd -
.14 Criter Rifge B CoordBasics10.0 ~
o @ B3 CoordWorkingl0_0

@ [ Crater Basins

=
= M Gusev_MOLA 2.tif

Value
™ High': 2840

-.
Low: -2870

a Gusev_Viking 2
Value
High:255

Low:0

= £ Ma'adim Vallis
@ O Crater Rims

= M Gusev_MOLA_2.tif
Value
™ High : 2840

-.
Low: 2870

B M Gusev_Viking_2
Value

I High : 255

i

— F

@ E3 Desktop
GDB_Start10.0

3 GDB_Topologyl0_0
@ [ GettingStartedGIS10_1
£ GTKArcGIS

& B3 Lpsc
£ 2018

Chapter 3 Practice
& E3 Chapter5 Practice
£| @ (3 Practice.gdb
B (3 Practice2.gdb
=] @ Craters
CraterBasins
CraterRims
8 Gusev_IRDay_100m
) Gusev_Viking_2
@] Practicel.mxd
@ Practice2.mxd
‘ 3 MapScripting10_0
£ PRA1116

@ E3 RasterBasics10_0
\ RasterOrganizel0_0
A SIRC
Steve's Data
3 UninstallUtility
death_valleyl.tct
death_valley2.bt
DeathValley.mxd L
Qe ;
[K] 10146318331 -748210.229 Meters

A. The Title bar shows the name of the application, ArcMap, and the name of the map document you are working with.

B. The top menu bar.

C. The Standard toolbar contains tools for managing the map document and controlling which elements of ArcMap are visible.

D. The Tools toolbar contains key tools and buttons you will frequently use, including most map navigation tools.

E. A data frame is a container for a map’s layers and can be used to organize them. Only one data frame can be active at any time
and this determines what you see in the main workspace.

F. The Table of Contents contains a list of all the data frames and layers in the map document.

G. A layer is an organized set of geographic features with the same type of geometry (point, line, polygon) or a raster (image).

H. The map display is the main workspace where you can view layers in a data frame and their components.

I. The map display buttons control whether you are in Data View, where you will work on editing the data frames and layers, and
the Layout View, where you will organize your data frames into presentable documents with elements like titles, keys,

and scale bars.

J. The Catalog window allows you to connect to ArcCatalog and perform some of the features of that applications including
exploring and organizing data. It also allows convenient loading of data by just dragging and dropping into the map

display.

K. This shows you the position of the cursor in the coordinates of the data frame. You can change the units shown here by going to
the Customize menu, selecting ArcMap Options, and on the Data View tab click “Use these units instead . . .” and use the
dropdown menu to set your desired units.

14



Exercise 1B: Working in ArcMap Chapter 1: Workspace basics

Step 1: Setting up ArcMap

> Start ArcMap and double-click Blank Map.

> From the Customize menu, select Extensions, and make sure all extensions are selected.

> From the Customize menu, go to Toolbars, and ensure that Standard and Tools are the only selections.

>

You may undock, move, and dock these toolbars. To do so, click and hold the four vertical dots on the left edge of
the toolbar, and then drag the toolbar to move it somewhere else. The toolbar can either be a stand-alone window
in the interior of the ArcMap window or be docked anywhere on the perimeter of the ArcMap window.

DRE& L EHE x| o |- 130000 V] B G E B3 g
Map Scale Editor I ArcToolbox
Toolbox
Search
Catalog
QA[O@ il e -0k |@ 7B MBS0,
I Full Extent IIdentify Measure I
Zoom Select Go To XY
& Pan Elements

The Standard and Tools toolbars with elements we will be using

If you do not see the Catalog tab on the right side of the ArcMap window, then from the Windows menu, select
Catalog.

You can also click Catalog 5l on the Standard toolbar. You can pin the tab by clicking the pin icon in the top right
corner of the window.

Under Folder Connections, go to the Exercisela folder and expand the GusevCrater geodatabase.

Notice that what you created in ArcCatalog is now accessible from within the Catalog window in ArcMap.

Step 2: Build geodatabase structure in ArcMap

>
>

YV VYV

In the Exercisela folder, right-click on the GusevCrater geodatabase, and under New, select Feature Dataset.
Name it LandingSites and click Next.

Notice that the SimpleCylindrical_Mars coordinate system is now shown in the Favorites folder.

This is because you used it in Exercise 1A.
Click on it.
Click Next, then Next again and then Finish.

Collapse the Exercisela folder.

15



Exercise 1B: Working in ArcMap Chapter 1: Workspace basics

Step 3: Load and explore a map document

>
>

YV V V V V VY

Expand the Exerciselb folder.

Drag and drop the GusevRegionLandingSiteAnalysis map document into the blank workspace.

Notice that the Table of Contents window to the left shows you everything in the map document.

Notice that the GusevBasemap layer has a red exclamation mark next to it.

This indicates a broken source path, so the map is looking in the wrong place for the data it needs to display the
layer.

Double-click on the GusevBasemap layer to open its Properties window.

Click on the Source tab.

In the Data Source frame, look at the Folder to see that the map is looking for a folder that does not exist.
Click Set Data Source.

Navigate to the Chapterl folder, and then into the Maps folder.

Select the GusevBasemap file there and click Add, and then click OK to close the Layer Properties window.
Now the proper image displays in the map.

Another way to do this is to right-click on the layer name in the Table of Contents and from Data select Repair
Data Source. Then navigate to the correct folder and file and click Add. This problem can be minimized by clicking
on Map Document Properties in the File menu and at the bottom of the window clicking the Store relative
pathnames to data sources box each time you create or work with a new map. You can also go to the Customize
menu and click ArcMap Options, and in the General tab check Make relative paths the default for new map
documents.

From the Bookmarks menu, choose Ma’adim Vallis.

Notice how this zooms and pans the map display to a specific setting. You can create new bookmarks to easily
return to specific views of the map by selecting Create Bookmark from the Bookmarks menu and naming it. The
current zoom/pan will be saved.

From the Tools toolbar, click Full Extent @ .

This return the map display to zoom/pan settings that show the entire extent of the data frame.

3 L]

Explore the map using the Zoom In #, , Zoom Out =, , Pan £, Fixed Zoom In 7 5, and Fixed Zoom Out . on the
Tools toolbar. After you have finished, click the Full Extent button.

c!‘ﬂ"
L

Although spaces and special characters are not allowed in ArcGIS for folder and file names, notice that in the Table
of Contents the displayed names for data frames, layers, and features do have spaces and special characters. These
are “aliases” and are merely part of the way the map is displayed, and so they do not have those restrictions.
Changing these aliases has no effect on the names of the files that are the data source.

Step 4: Working with layers

>

Right-click on the Slope & Elevation data frame and select Activate.

Notice that this completely changes what is viewed in the map display, which is now showing within this data
frame. Slope & Elevation is now in bold in the Table of Contents, indicating that it is active, and Landing Sites is no
longer bold. Only one data frame can be active, and therefore viewed in the map display, at a time.

The Catalog window also uses bold to show you which map document you currently have open.

16



Exercise 1B: Working in ArcMap Chapter 1: Workspace basics

Layout v X
SR EEIEEFEE EREERYE
! |

Zoom Full Page

Change Layout

Zoom
& Pan
The Layout toolbar with elements we will be using

Y

Right-click on the Potential Landing Sites layer in the Landing Sites data frame and select Copy.

Y

Right-click on the Slope & Elevation data frame and select Paste Layer(s).

» Click and drag the Gusev Basemap layer just above the Combined Analysis layer.

The order of the layers in the Table Of Contents determines what is visible in the map display. Since the basemap is
not transparent, the Combined Analysis layer underneath it is no longer visible.

> Click to uncheck the box next to the Gusev Basemap layer to turn off the layer.

The Combined Analysis layer is now visible.

Y

Move the Gusev Basemap layer back to the bottom of the Slope & Elevation data frame and turn it back on.

> Right-click on the Potential Landing Sites layer in the Slope & Elevation data frame and select Remove.
Alternatively, click Undo until the layer is removed.

> Activate the Landing Sites data frame.

This can be done as earlier, or using the short cut of holding down Alt key while clicking on the data frame.

Chapter Summary

Now you have seen some of the basic the capabilities of ArcCatalog in organizing and exploring data, as well as the
basic structure of a map document in ArcMap. Feature datasets and raster data sets are not necessary, but they can be
useful for organizing large amounts of data. Rasters brought in from downloaded and processed images also do not
necessarily need to be stored inside geodatabases, and since these files may be large and you may want to use them in
different analyses using different geodatabases, it can be prudent to leave them in a separate folder as is done in these
exercises. Rasters produced through analysis should be stored within a working geodatabase and can be exported later
to share with others.

17



Working with

rasters

Exercise 2A: Raster Basics

Estimated time: 25 minutes

Exercise 2B: Slope Analysis

Estimated time: 30 minutes

18



Chapter 2: Working with rasters

Introduction

In this chapter you will learn the basics of loading, symbolizing, and analyzing raster data. Rasters are analogous to
image files. They contain an array of pixels, called cells, each with a position and a single value which could represent
brightness, elevation, intensity of a quantity, or any other numerical data. A raster basemap is usually the starting point
for any map product, and is typically an aerial or orbital image or mosaic of images. Rasters can be organized into
datasets within geodatabases, but can also be stored outside of geodatabases. Since rasters are typically the most
demanding of storage space among GIS files, we will keep the starting images that were downloaded for use in this
workshop in a single file outside the geodatabases we will be working in. Rasters produced from analyzing these
images will be stored within individual geodatabases designated for each exercise.

Objectives

> Load downloaded and processed images as rasters in ArcMap

» Utilize the Standard, Tools, and Effects toolbars to investigate and display rasters
» Find locations and take measurements of features in a raster

> Symbolize rasters, both continuous and discrete

» Analyze rasters to produce new raster products

> Perform slope analysis

» Convert continuous rasters into discrete rasters

> Modify labels in preparation for layout mode

Terms

> Raster

> Basemap

> Elevation Map

> Cell Size

> Symbology

> Geoprocessing Tools: Slope, Reclassify

> Toolbars Buttons: Pan and Zoom, Measure, Transparency, Swipe
> Windows: ArcToolbox, Search, Image Analysis

» Hillshade

> Spatial Analyst Toolbar

19



Exercise 2A: Raster Basics

Estimated Time: 25 minutes

Step 1: Load a raster basemap and elevation map

>

YV VYV V V V

A\

Start ArcMap, and click cancel in the Getting Started window.

Create and name a new folder connection in the Catalog Tree to the Imagery folder.

Also create a connection to the Chapter2 folder and name it Chapter 2 (with a space).

Collapse the Home directory if it has automatically expanded.

Chapter 2: Working with rasters

Expand the Imagery folder, expand THEMIS_IR_100m, and drag-and-drop GusevBasemap into the map display

area.

When asked about creating pyramids, set Pyramid resampling technique to Bilinear Interpolation and click Yes.

Pyramids allow the display to adjust to the scale and not display the entire image at small scales, thus speeding up

the display.

Notice that the coordinates in the lower right are in meters, showing that this raster has been projected.

If the image looks dark or all black, that can be fixed in the next step.

In the Imagery folder, expand MOLA_463m, and drag-and-drop GusevElevation into the map display area.

Build pyramids with the same settings as the basemap.

Layer Properties X

General Source Key Metadata Extent Display Symbology Time
Show:

Vector Field

Ftretch values along a color ramp

&la

Unique Values
Classified
Stretched
Discrete Color

Show =——

Color Value Label

Labeling

2840 [ High : 2840 |

Edit High/Low Values [] | I
-2870 |Low:-2870 I

~

Cancel

Color Ramp: l i Color Ramp
[Jisplay Background Value: 0 as|[|~
[Juse hillshade effect Zi|1 Display NoData as|[_]| v
Stretch
Type: Minimum-Maximum v e ki Stretch Type

: 3 Oinvert
ey X
P [C] Apply Gamma Stretch: 1 ”

Apply

The Symbology tab with elements we will be using

20
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Step 2: Explore and symbolize a raster

>
>

Y

Y VY

YV V V V

Double-click on the GusevElevation layer in the Table of Contents to open the Layer Properties window.

Click on the Source tab.

This tells you the location of the source data as well as other information like resolution (cell size), pixel type and
depth, and units of measure.

Click on the Symbology tab.

Since this raster is considered continuous (even though pixel values have been restricted to integer values) the
Stretched option is selected by default for Show on the left. If the image is dark or all black, try changing the
Stretch Type selection from the drop-down menu (default is set to Percent Clip). Minimum-Maximum usually
works well, but try others to see which looks best. You can also do this to your basemap if it has a similar problem.

Set Show to Classified (right above Stretched).

If asked about computing a histogram, click Yes.

In order for ArcMap to decide how to group the pixel values into a few classes, each with a range of values, it must
first perform some standard statistics on the frequency distribution of pixel values among the cells. This is a
common message when working with a new raster in ArcMap, and there is generally no reason for refusing.

Then click Apply to see the data displayed discretely.

You can move the Layer Properties window out of the way if necessary to see the map display.

Change back to Stretched and click the arrow for the Color Ramp drop-down menu to see different color schemes.
Click outside the menu to collapse it, then right-click on the Color Ramp and unclick Graphic View.

Open the drop-down menu again and choose Elevation #1, and click OK to close the Properties window.

You can quickly access the color ramp by going to the Table of Contents and left clicking once on the color ramp
under the layer name.

: Tects v X ]
[ GusevElevation ~|l D (@Y 5] 500 |5

1 I 11 '
Layer effects will Swipe
be applied to

Contrast Tmnspﬂ.rency

Brightness

The Effects toolbar with elements we will be using

Go to Customize on the top menu and from Toolbars click Effects.
Dock this toolbar wherever you like.

You can also add toolbars by right-clicking in any blank gray space around the other toolbars.
In the Effects toolbar, select the GusevElevation layer from the drop-down menu.

Click Swipe & .

Click and hold anywhere in the map display and drag the mouse up and down.

In the Effects toolbar, click Adjust Transparency £ and change the setting to 50%.

Now the basemap layer can be seen under the elevation layer.
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Exercise 2A: Raster basics Chapter 2: Working with rasters

> In the Effects toolbar, select the GusevBasemap layer from the drop-down menu.

> Experiment with adjusting the display with Adjust Contrast (B and Adjust Brightness until you are satisfied
with the appearance of the map.

Table Of Contents 2 x
g8l
& 5 Layers

B @ GusevElevation.tif

Value
| High: 2840

Low: -2870

I High: 255

Low:1

@elen « " I

i Drawing~ K () &[0~ A ~ /< | [0 Aial ~0 B UlA-N- 2. -

Basemap and elevation layer loaded and symbolized

Step 3: Locate positions on a raster

> From the Tools toolbar, click Go To XY & .

Click the units ¥ drop-down menu and select Decimal Degrees.
Enter Long: 175.5 and Lat: -14.5.

Click Flash - to see that this location is the approximate center of Gusev Crater.

YV V V V

Close the Go To XY window.

Choose Units
M Choose
easure an

Area Measurement Type

To measure a distance, draw a line.

A To measure an area, dick 'Measure An Area’ then
Measure Line || draw a polygon.

To measure a feature, dick 'Measure A Feature'
then dick a feature.

The Measure window with elements we will be using
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Step 4: Measure features on a raster
> From the Tools toolbar, click Measure %, .
Measure A Distance v is selected by default.

» Click the Choose Units v drop-down menu and set both Distance and Area to kilometers.

> Click once anywhere on the rim of Gusev Crater, move the mouse to the opposite rim, and then double-click.
The Measure window displays the approximate diameter of the crater (should be 160 km + 10 km).

» Pick two very small craters that are far away from each other on the map.

» Measure the distance between them and note the result.

> Click the Choose Measurement Type drop-down menu and change from Planar to Geodesic.

> Make the same measurement again and note the difference.
Planar will calculate a Euclidean distance using the projected coordinates assuming the surface is flat. Geodesic
takes the curvature of the surface into account.

» Click Measure An Area 4 .

» Click anywhere on the rim of Gusev Crater, then use single clicks periodically as you move the mouse along the rim,

and double-click when you have come back to near your starting position.

The Measure window displays the perimeter and area of the polygon you just specified (roughly 500 km and
19,000 kmz) Image Analysis 0o x
Options =—— [

€2 ShadedRelief_GusevElevation, tif
Layers = [7] < GusevElevation. tif
] @GusevBasemap.tif

> Close the Measure window.

Optional: Relief effects

< | m | *r

. . . . e — ED
Step 5: Visualize terrain without a basemap [ Display =
) - 0 [ o]
> From Windows in the top menu, select Image Analysis. , 0 |j
> Turn off the GusevBasemap layer by unchecking the box next to the - — naly , el
. . . ects Yy T [100]
layer name. Notice that this also turns off the layer in the Table Of Cloe: T
Contents. [ IBackground
3 [ _ .
> Click on the name of the GusevElevation layer to highlight it. This Min-Max gh == b
activates it as the layer you are doing analysis on. Set the e Sl ‘
+E = | 500
Transparency £ to 0% and change the stretch type to Min-Max. = =
Raster Analysis | Processing i
> Click on Image Analysis Options :Z| at the top of the window and in Tools = W H = & F 2
the Hillshade tab set Z Factor to 3 and click OK. K
Shaded Relief —— | WL S | i
> In Processing, change the color ramp to one of the grayscale ramps. (elend <) E
» Click on Shaded Relief @ to the right of the color ramp. (Sharen )

Mensuration =]
Hillshade can also be added in the Symbology tab, but the Z value e E B, B
there is normalized and should be set much lower, such as 0.1. In S Tr———
Image Analysis, the Z value is in the units of the elevation map,
which for this map is meters.

The Image Analysis window
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>
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Y

A new layer is added to the map document and a new TIFF file has also been created.

Click on the new layer at the top of the Image Analysis window to highlight it.

Click the Save icon (Export Raster Data [ ) in Processing to save this new TIFF.

Set the Location to the Imagery folder, name the file GusevHillshade.tif and click Save.

Click No on the first dialog window and then click Yes on the second.

Right-click on the Hillshade_GusevElevation layer and select Remove.

This file was likely stored in a temp folder somewhere, but we want to view the exported one in the map.
In the Table of Contents, turn the GusevElevation layer off and turn the GusevBasemap layer back on.

Use the Swipe tool (also accessible in the Image Analysis window) to compare the basemap terrain to the hillshade
terrain. Make sure that the GusevHillshade layer is selected as the one to swipe.

Explore other features of the Image Analysis window.

Close the window when you are done.

Table Of Contents 2 x
8o 8
s SEE

@ M Hillshade_GusevElevation.tif

Value
High: 255
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B [0 GusevElevation.tif
Value

. High : 2840

" Low: -2870

=] GusevBasemap.tif
Value

I High:255

Low:1

Artificial basemap created with Shaded Relief
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Chapter 2: Working with rasters

Exercise 2B: Slope Analysis

Estimated Time: 30 minutes

Step 1: Set up the workspace for analysis

» From the Catalog window, navigate to the Exercise2b folder and drag and drop the GusevCrater2b map document
into the display.
> Right-click on the GusevCrater geodatabase in the Exercise2b folder and select Make Default Geodatabase.
This is a very useful thing to do every time you start working in a geodatabase since it will allow you to quickly
navigate to this geodatabase when storing any files you create during analysis.
» On the Standard toolbar, click ArcToolbox @ to open the ArcToolbox window.
» Dock it wherever you like (typically on the right side) and Auto Hide it if you wish by clicking the pin icon in the
upper right to turn it from up-down to side-to-side.
If a window is on Auto Hide, it will appear as a tab in its dock position. You can open the window by hovering over
or clicking the tab.
> Explore the available tools for a few minutes.
Note just how many there are and how confusing it would be to try and remember where all of them are.
» Ifitis not already open (likely docked on the right), open the Search window by clicking Search @ on the Standard
toolbar.
Dock and Auto Hide as you wish. This window allows you to search for tools and help topics.
Search a x
Step 2: Find the slope tool 7|8 2|9 [ocaiseaen -
ALL  Maps Data Tools Images
> Type slope into the search textbox and hit enter. Search Term == [slope @
. . Any Extent =
Several matches come up, with the main toolbox they belong Tool Name .
to in parentheses after their name. We want to use the Slope (click to open) Fesarci e AP e g oo
. "®Surface Slope (3D Analyst) (To...
tOOI from the Spatlal Ana|y5t tOOIbOX. Creates polygon features that rep...
o ) . . . /toolboxes\system toclboxes\3d a...
CI.|ck.|ng on the first line Pf th|§ entry will open the tool fqr use, Link to Help { stope (30 Analyst) (ool
clicking on the second line will open the help files relating to Idalr];tifiestha slope (‘gbrad‘went.dor...
it, and clicking on the third line will take you to where the tool Location in i il s
S 1 fi
is in ArcToolbox. You can also see the toolbox path to this tool ArcToolbox Y B (St aralysn) (ol .
by hovering over the third line. toolboxes\system toolboxes\spati...
#, Surface Aspect (3D Analyst) (T...
Creates polygon features that rep...
toolboxes\system toolboxes\3d a...
Step 3: Use the Slope tool #, Aspect (3D Analyst) (Tool)

The Search window

> Click Slope (Spatial Analyst) in the Search window to open the tool.

You can also go to where the tool is in ArcToolbox and double-click on it there to open it.

> Click Show Help to see information about the tool, and as you click on each field it will show information about it.

If this is already open, it shows up as a white box with a description of the tool to the right of the window. To hide
the information, click on Hide Help.

25



Exercise 2B: Slope analysis Chapter 2: Working with rasters
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>
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Use the drop-down menu in Input raster to select GusevElevation.

For Output raster, click Browse % , click Go To Default Geodatabase |3 , and name the file Slope and click Save.

You can look at the file path in the Output raster field and see if you are in the GusevCrater geodatabase in the
Exercise2b folder already, and if so you can just change the file name here without clicking on browse.

Click OK to run the tool.

You will see a scrolling message in the lower right showing that the tool is running, and a window will appear in the
corner when it is finished with a green check mark indicating it successfully ran.

If the tool did not successfully run, an “X” in a red circle will appear and clicking on the tool name will open the
Results window where details of the processes can be viewed, including any errors that occurred.

The new raster is automatically added as a new layer in the map.
Open the Layer Properties for the Slope layer by double-clicking on it and go to the Symbology tab.

Set Show to Stretched and set the Color Ramp to Slope (remember to uncheck Graphic View to see the names of
the color ramps).

Set Stretch Type to Percent Clip.
Click OK.

Table Of Contents a2 x

S ¢8I

8 £ layers
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Results of Slope Analysis

Step 4: Export the result

YV V V V

This new image file cannot be accessed outside of ArcMap because we put it inside a geodatabase. The file must be
exported to make it available for sharing and use in other programs.

Right-click on the Slope layer and from the Data menu select Export Data.
For Location, click the browse button, navigate to and highlight the Imagery folder.
Click Add.

Name the output file Slope.
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>
>

Click Save.

Click No to whether to add the output as a map layer.

This image can now be accessed through Windows Explorer and shared for use in other maps. It preserves all the
spatial data or the raster.

Step 5: Perform statistics on a raster

YV V.V V V VY

Right-click on an empty space on the toolbar area.

Activate the Spatial Analyst toolbar.

From the dropdown menu, choose the Slope layer.

Click Create Histogram |l .

Right-click anywhere on the histogram window, and select Export to see a variety of options for saving the data.

Close the Export window, then close the Histogram window, and then close the Spatial Analyst toolbar.

Step 6: Reclassify a raster

Y

YV V V V V V

When the Slope layer first appeared, the Symbology was set to Classified and the raster was displayed as discrete.
However, the source data is still floating point numbers. To create a discrete raster, we must use a tool.

Use the Search window to find the tool Reclassify (Spatial Analyst) and open it.

This tool will group pixel values into specified ranges and reassign the pixel values as 1, 2, 3, etc.
Select Slope as the Input raster.

Click Classify.

Set the Classes to 3.

Set the Method to Manual.

Change the first value in the Break Values list to 5 and the second to 15 (leave the third number as is).

Click OK.

You can also edit the table directly on the Reclassify window by retyping in the Old Values column and deleting or
adding rows.

Name the Output raster SlopeReclass, and click Save.

Check that you are in the geodatabase in the Exercise2b folder.

Click OK to run the tool.
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Results of Reclassify and symbolizing the Slope layer

Step 7: Symbolize a discrete raster

V VV V YV V VYV VY

Click on the Symbology tab.

Double-click on the color next to the value 1.
Select Medium Apple (row 3, column 7).
Set the color for value 2 to Solar Yellow (row 3, column 5).

Set the color for value 3 to Mars Red (row 3, column 2).

Open the Layer Properties window for the SlopeReclass layer.

Click on the 1 in the Label column and change it to <5 degrees.

Then change the 2 to 5-15 degrees, and change the 3 to >15 degrees.

Chapter 2: Working with rasters

This only changes what is displayed next to each color in the Table of Contents. Because these are aliases, spaces
and special characters can be used, and it does not alter the actual pixel values, which will remain 1, 2, and 3.

Y

Click OK.

Y

Close ArcMap or continue to the Optional exercise.

Optional: Reclassify the Elevation raster

Repeat steps 6 and 7 to reclassify the Elevation raster into elevations less than -1000 m and elevations greater than -
1000 m. Symbolize the low elevations with green and the high elevations with red. You can change the colors by going
into the Layer Properties window as we did before, or by right-clicking on the color you want to change in the Table of
Contents. Turn off the Slope and GusevElevation layers and make both reclassified layers transparent. In this view,
bright green regions are both low elevation and low slope, whereas bright red regions are both high elevation and high

slope. Adjustments like this to display properties can help you do quick by-eye analysis before deciding what tool
analysis you would like to do next.

Close ArcMap when you have finished.
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Chapter Summary

Results of Reclassify and symbolizing the Elevation layer

Chapter 2: Working with rasters

In this exercise you have learned some of the basic tools for displaying, exploring, and symbolizing rasters. You have
also been introduced to using tools from ArcToolbox to analyze rasters, and how to export the results. You have seen
how to change the appearance of the Table of Contents, which does not affect anything about the source data and is
only saved within the map document. In addition to making your map easier to interpret, these changes will carry over

to the map in Layout Mode making your finished product easy to read and understand.
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Working wi

vector data

Exercise 3A: Creating and editing feature classes

Estimated time: 40 minutes

Exercise 3B: Using selection

Estimated time: 25 minutes

Exercise 3C: Tools for modifying and analyzing features

Estimated time: 15 minutes
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Chapter 3: Working with vector data

Introduction

In this chapter you will learn the basics of vector data. These are geometric objects on a map, called feature classes,
that contain spatial reference data. These objects may be points, lines, or polygons. Unlike rasters, in which each cell
can only store one numerical value, feature classes contain geometric information for each feature, such as length and
area, and can also store unlimited other values that can be numerical, descriptive, images, or hyperlinks. Creating
feature classes to represent objects in rasters, such as craters, valleys, cloud bands, or geologic regions, allows for even
more extensive analysis of these objects since so much information can be stored without always needing to create a
new file, as with rasters. We will learn how to create feature classes from scratch, which is recommended when
conducting your own research, but we will also show how to use and manipulate existing vector data, which is helpful
for initial investigation.

Objectives

Create new feature class

Work in editing sessions

Digitize new vector data

View attribute tables

Symbolize vector data

Use selection methods

Create features from existing features

Create and calculate new attributes

YV V V V V V VY VYV VY

Analyze features

()
=
3
wn

Vector Snapping

Feature Class Attribute Table

Polyline Query

Editor Toolbar Selection

Edit Session Fields

Streaming Hot Spot Analysis

Vertices Buffer

VV V V VYV VYV VYV VY
VV V V VY VYV VYV VY

Construction Tools Average Nearest Neighbor
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Exercise 3A: Creating and editing feature classes

Estimated Time: 40 minutes

Step 1: Open a new map document and add a basemap

> In ArcMap, open a new blank map.

> In the Catalog window, add a folder connection to Chapter3 and name it Chapter 3.

> Go to the Exercise3a folder and make the GusevCrater geodatabase there the default if not already.

» In the Imagery folder, expand THEMIS_IR_100m and drag and drop the GusevBasemap raster into the map
display.

Step 2: Create a new feature class.

> Right-click on the Craters feature dataset in the default geodatabase, and from New select Feature Class.
» Name the feature class CraterRims with an alias of Crater Rims.
The alias is what will be displayed in the Table of Contents and the Layout mode, and so is allowed to have spaces.
> Select Line Features for the type. Click Next, accept the default, and click Next. Click Finish.
Once a geometry type is set for a feature class, it cannot be changed through any editing methods.
> Expand the Craters feature dataset in the Catalog Tree to see the newly created CraterRims feature class.

Notice how the feature class is automatically added as a layer to the map with the alias name. It is turned on but no
features are visible, because the feature class has no data.

: Editor~ [ ] " |/ 2 41+ 5 IS Me i 4 Q| By

t t f

Edit Tool Edit Vertices
Create Features
Editor Menu (Start, Save, Reshape Feature
and Stop Edit Sessions) Tool

The Editor toolbar with elements we will be using

Step 3: Digitize a crater rim using a circle
> Activate the Editor toolbar and dock it somewhere.
> Choose a crater that looks fairly circular, and zoom in on it (smaller craters work best).

> From the Editor menu Editor = in the Editor toolbar select Start Editing.

This starts an Editing Session in which source data can be altered. Within the session, changes can be undone and
must be saved regularly and before ending the session. If you are editing a feature class that already contains
features, it is highly recommended that you have an original copy of the file stored somewhere.

32



Exercise 3A: Creating and editing feature classes Chapter 3: Working with vector data

>
>
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From the Editor toolbar, click on Create Features [ .

Select CraterRims by clicking it once.

Even though it may look highlighted, you still need to click on it.

From Construction Tools, select Circle.

Move the cursor to the approximate center of your crater, and click once.

Drag your cursor away from the center, until the circle closely matches the crater rim.

Click again to create the circle feature.

Having to start at the center can make it hard to line the feature up with the rim, so if the circle is off center just
focus on making it the correct size.

If your circle is not well aligned to the rim, click the Edit Tool . from the Editor toolbar.
Hover over the circle until the four-pointed arrow appears.

Click and drag the circle until it is better aligned.

When using the Editor Tool, the feature needs to be selected to be edited. Selected features will be highlighted in
blue. To select a feature, click on it once.

From the Editor menu, click Save Edits.

Step 4: Digitize a crater rim using streaming

YV V.V V V V

Y

Y

Using Pan 4"

, find a crater with a well-defined rim that is somewhat irregular (non-circular).
Zoom in on this crater.

From Construction Tools, select Line.

Right-click anywhere in the display and check Streaming.

In the Editor menu of the Editor toolbar, select Options.

In the General tab, set the Stream tolerance to 500 (make sure your map units in the lower right are in meters).
This sets the interval between vertices that will be automatically added as you draw.

Click OK.

This tolerance depends on the scale of your map product, but usually 2 to 5 times the map resolution works best so
that the line looks curved even though it is made up of many straight segments.

Click once anywhere on the crater rim.
Once you click, any movement of the mouse will be drawing a line, so be ready.

Carefully trace the crater rim with your mouse.

If you make a mistake, double-click to stop drawing and click Undo, or hit delete. You can also adjust it later using
methods described in the next few steps.

When you have finished tracing the rim and have returned to your starting position, double-click to stop drawing.

From the Editor menu, click Save Edits.

33



Exercise 3A: Creating and editing feature classes Chapter 3: Working with vector data

Table Of Contents 8 x
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Close-up of two digitized crater rims, one using a circle and one using streaming

Alternative Method: Digitize without Streaming turned on

> After you click once to start drawing, you will need to manually click as you move along the rim to place vertices.

Some people prefer this.

> Double-click to stop drawing. Snapping v X|
Snappingr O B O O

The Snapping toolbar
Step 5: Edit an existing feature

> Click the Pan tool, and zoom in on the position where you started and stopped your drawing.
Notice how the two ends do not meet.

> From the Editor menu on the Editor toolbar, go to Snapping to activate the Snapping toolbar.

This toolbar can also be added like other toolbars by methods previously described.

> If any of the four snapping buttons is highlighted, click it to turn it off.

> From the Editor toolbar, select Edit Vertices [ .

» Clickand drag one endpoint to the other end.
You may also click and drag other vertices to smooth out the line in the vicinity, or use Add Vertices P to create
additional vertices between existing vertices and move them to improve the feature’s shape.

» When you are done, click Finish Sketch {1 in the Edit Vertices toolbar to accept the changes.

» Close the Edit Vertices toolbar.

> Use the pan tool to zoom in further on the starting/stopping point. Notice the two ends still do not meet.
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Step 6: Edit using snapping

>

>
>
>

Y

YV VY

On the Snapping toolbar, activate End snapping B .
Select Edit Vertices from the Editor toolbar.
Again, click and drag the end of one line to the other.

Notice how as you hover over the other end, a large square appears at the other endpoint that remains when
moving the mouse as long as you are close to this point.

Release the mouse when this square is visible.

Snapping allows you to connect the two vertices without them needing to be exactly lined up.
Click Finish Sketch on the Edit Vertices toolbar and close the toolbar.

From the Editor menu, click Save Edits.

From the Editor menu, click Stop Editing.

Alternative Method: Digitize a crater basin using a polygon

VV V V YV VY VY V V

Y

YV VYV

Go to the Catalog window and follow the instructions from Step 2 to create a new feature class.
Name it CraterBasins with an alias of Crater Basins.

Select Polygon Features for the type.

Click Next twice, and then Finish.

Pan and zoom to a crater with a well-defined irregular rim that you did not digitize before.

Start a new editing session.

Click on Create Features [ .

Select the CraterBasins layer and select Polygon from Construction Tools.

Turn off all the Snapping buttons.

Since you are creating a polygon, you do not need snapping. You can choose whether or not to use streaming.

Begin tracing your polygon by clicking once anywhere on the crater rim, and continue along the edge, clicking at
regular intervals.

When your polygon fills the whole crater, double-click to finish it.

From the Editor menu, click Save Edits and then click Stop Editing.
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Table Of Contents
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Close-up of three digitized craters. One is a rim using
streaming, one is a rim using a circle, and one is a basin using
a polygon.

Additional Tools and Tips

> Snap to Sketch (Snapping drop-down menu in the Snapping toolbar) will help close polyline shapes by allowing you

to snap to a point in a polyline feature you are currently digitizing. Turn on all Snapping options before using this
feature.

> If you are drawing features that are close to other features and you want them to remain separate, turn all
snapping off. You can also temporarily suspend snapping in the middle of drawing by holding down the spacebar.

> Reshape [1: on the Editor toolbar will allow you to redraw portions of the feature without having to individually
move vertices. It is best to turn snapping options on. Click once on the vertex where you want to start redrawing,
draw a new path to the vertex where you want to stop redrawing, then double-click to finish.
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Exercise 3B: Using selection

Estimated Time: 25 minutes

Step 1: Import a shapefile

>
>
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From the Catalog window, open the map document GusevCrater3b in the Exercise3b folder.
Make the geodatabase in that folder the default.

Also in the Catalog window, locate the CraterData folder (in the Exercises folder) and expand it to find the
RobbinsCraterDatabase_GusevRegion shapefile.

Since this is a shapefile (not ArcGlIS specific) it cannot be simply copied and pasted into a geodatabase. It will need
to be converted into a feature class. You can still add shapefiles to the map document, but certain processes can
only be done on feature classes.

Right-click on the GusevCrater geodatabase in the Exercise3b folder and from Import select Feature Class (single).
For Input Features, browse to the CraterData folder and select the shapefile.

The Output Location is already set to the default geodatabase.

Name the Output Feature Class CraterPointsRaw.

Click OK.

The new feature class is automatically added to the map as a new layer.

‘Table Of Contents

Elsc&ia

High: 255

Low:1

Shapefile of crater centers imported as a feature class

Step 2: Project the new feature class

>
>

ArcMap has projected the new layer “on the fly” based on geographic coordinates, but the CraterPointsRaw
feature class has no projection of its own, and therefore has no sense of linear units for calculating distances. To
perform spatial analysis, we need to project it.

Use the Search window to find and open the Project (Data Management) tool.

For Input Feature Class choose CraterPointsRaw.
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Exercise 3B: Using selection Chapter 3: Working with vector data

> For Output Feature Class, navigate to the default geodatabase and name it CraterPoints.

> For the Output Coordinate System, click the button to the right, and under Add Coordinate System ¢ select
Import.

Y

Find the GusevBasemap raster in the THEMIS_IR_100m folder under Imagery and select it.

Y

Click OK to run the tool.

> Right-click on the CraterPointsRaw layer in the Table Of Contents and select Remove.

This does not delete the feature class. It only removes it from the map document.

Step 3: Select features by attribute values to highlight small craters

Click on Selection from the top menu and choose Select by Attributes.

Select the layer CratersPoints.

For Method keep the default Create a new selection, but open the drop-down menu to see the other choices.
In the fields box, double-click on DiamKM. Notice how this text is added to the query box below.

Click the less than symbol (<).

YV V V V V VY

Click Get Unique Values, and scroll down to 1.5. Double-click on it to add it to the query. You can also type 1.5 into
the query box after the less than symbol.

The query box should now read: DiamKM < 1.5

In earlier versions of ArcMap, the query might have quotation marks around DiamKM.

Y

Click Apply to see the selected craters highlighted on the map display.
» Click OK.

I

Select By Attributes

Layer:
] Only show selectable layers in this list
Method: Create a new selection e
OBJECTID NN
LON_E
LAT Fields Box
DiamKM
CraterlD v
o e
> | [>=] [2na]
Relational e )
symbols S S| WX
e o] [het]
s | [ | [Nui| | Get Unique Values +5oFo- Get Unique
SELECT * FROM CraterPoints2 WHERE: Values
Query Box

Clear Verify | Help Load... Save.
Apply Close
Select By Attributes and the elements we will be using

38



Exercise 3B: Using selection

Step 4: View selected features in the attribute table

> Open the attribute table for the CraterPoints layer.

Chapter 3: Working with vector data

This can be done either by right-clicking and selecting Open Attribute Table, or for Windows machines by double-
clicking on the layer while holding down the Ctrl key.

The attribute table has arranged the craters by decreasing size, so none of the selected features are visible without

scrolling down.

> Right-click on DiamKM and select Sort Ascending.
Now we see that the selected craters are highlighted just like on the map display.
> At the bottom of the attribute window, click Show selected records = .
> Scroll down to see that only selected features are shown in the table now.
> At the bottom of the window, notice how 391 craters have been selected from a total of 897.
> Close the attribute window.
Table O X
EMCHL T LG RIEE T
CraterPoints X
OBJECTID * Shape* | LON_E LAT | DiamKM| CrateriD Radit A
» 507 | Point ZI 178.618| -14.183 1.49 (23-009099
508 | Point ZI 176.652| -14.802 1.49 (23-009115
509 | Point ZM 179.865| -13.108 1.48 (23-009197
510 | Point ZI 177.892| -15.187 1.48 (23-009217
511 | Point ZI 179.166| -12.57 1.48 [23-009245
512 | Point ZM 174776 | -17.678 1.48 [23-009251
513 |Point ZM 178.507| -15.627 1.48|23-009260
514 | Point ZI 174.734| -11.409 1.47 [23-009301
EAE | Daint 711 177 241 18 2RA 1 AR 172 NNQATE ¥
< >
4 4 » » | E B3| (391 out of 897 Selected)

|~ CraterPoints |

The Attribute Table

Step 5: Create a new layer from selected features

> Right-click on the CraterPoints layer, and from Selection click Create Layer From Selected Features.

A new layer appears just above the original layer.

> On the Tools toolbar, click Clear Selected Features [ .

> Turn off the CraterPoints layer.

The new layer only displays the craters less than 1.5 km in diameter.
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Exercise 3B: Using selection Chapter 3: Working with vector data

Table Of Contents 2 x
8¢8I
B & layers
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(<]

© @ GusevBasemap
Value
High: 255

Low:1

Selection of craters with diameters less than 1.5 km

Step 6: Create a feature class from a new layer

>

YV V V

YV V V V V

Y

Look at the Catalog window and notice that CraterPoints selection does not appear as a new feature class.

It is a layer based on the same source data as the CraterPoints layer, and so it only exists in the map document. If
you look at the Source tab in the Layer Properties for this layer, you will see it is still getting its data from the
CraterPoints feature class, just like the CraterPoints layer.

Right-click on the CraterPoints selection layer and from Data select Export Data.
Click the browse button for the Output feature class.

Go to the default geodatabase and name the new feature class SmallCraterPoints.

Ensure that the file type is File and Personal Geodatabase feature classes.

Click Save and then OK.

Click Yes to add this feature class to the map display.

Notice in the Catalog window there is now a new feature class named SmallCraterPoints.
Right-click on the CraterPoints selection layer and click Remove.

Click once on the symbol for the SmallCraterPoints layer in the Table of Contents to open the Symbol Selector
window.

Symbolize this feature class by changing the fill color to Electron Gold (row 3, column 4) and increasing the size to
8.
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Chapter 3: Working with vector data

Exercise 3C: Tools for modifying and analyzing features

Estimated Time: 15 minutes

Step 1: Analyze crater size distribution

YV V V V V V VY

Open the map document GusevCrater3c in the Exercise3c folder and make the geodatabase there the default.
Use the Search window to locate the Hot Spot Analysis tool and open it.

For Input Feature Class choose SmallCraterPoints.

For Input Field choose DiamKM.

For Output Feature Class, navigate to the default geodatabase and name the feature class SmallCraterHotSpot.
Keep the other default settings and click OK to run the tool.

Turn off the SmallCraterPoints layer and in the Symbology tab for the Hot Spot layer increase the point size to 12.

To edit multiple symbols at once, open the Symbology tab in the Layer Properties window and highlight all the
classes. Right-click anywhere in them and select Properties for Selected Symbol(s). Then change the point size to
12.

The resulting feature class shows places where there are high concentrations of smaller craters in blue and high
concentrations of larger craters in red. This can serve as a quick assessment of whether a distribution is random or
not.

Turn off the SmallCraterHotSpot layer and collapse it.

VORI B

‘Table Of Contents

Elscs8l

85 layers
a

@ Cold Spot - 9% Confidence
@ Cold Spot - 95% Confidence
(© Cold Spot - 90% Confidence
(O Not Significant

( Hot Spot - 90%

@ Hot Spot - 95% Cont
@ Hot Spot - 99% Confi
© O SmalCraterPoints

® O Craterpoints
.
® O CraterPolygons
a
© @ GusevBasemap
Value

High: 255

Low:1

Results of Hotspot Analysis on small craters

Step 2: Buffer the crater points to create approximate polygon features

> Turn on the CraterPoints layer.

> From the Geoprocessing menu, select the Buffer tool to open it.

Some commonly used tools can be quickly accessed from the top menu.

> For Input Feature Class choose CraterPoints.
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Exercise 3C: Tools for modifying and analyzing features Chapter 3: Working with vector data

>
>

Y VYV

>

For Output Feature Class, click on the browse button and name the file CraterPolygons.

Select Field for Distance and from the drop-down menu choose RadiusM.

This is why we created this field so that we would have a distance in meters on which to base circular buffers.
Keep all the other default settings and click OK to run the tool.

Symbolize the new polygon layer with no fill color and a Medium Apple (row 3, column 7) outline with width 1.5.

Pan and zoom to explore these circular approximations of the craters.

The buffer circles work fairly well for larger craters, but zooming in reveals that this crater database is not lined up with
our basemap. You can try using the Measure tool to see approximately how much the offset is. This is likely due to the
database being based on an outdated datum or projection. ArcMap attempts to project new layers “on the fly”, but this
does not always work well. You could try performing transformations to the old database to get features to line up
better, but this is also illustrates the importance of creating your own data from scratch.

Table Of Contents ax
881
8 & Layers
O SmallCraterPointsHotSpot
@ 0O SmallCraterPoints
«

© @ CraterPoints
.
© @ CraterPolygons
© @ GusevBasemap
Value

High : 255

Low:1

i

Craters modeled by circular polygons

Optional: Calculate circumference and area for the crater points

>

YV V V V V

Copy the CraterPointsRaw feature class from the geodatabase in the Exercise3b folder and paste it into the
geodatabase in the Exercise3c folder.

Add the new CraterPointsRaw feature class to the map.

As in the demo, create new fields titled CircM and AreaM2 and calculate circumference and area from the radius.
Open the CraterPolygons attribute table and view both tables.

Compare the CircM and AreaM2 field values to the Shape_Length and Shape_Area field values.

Turn off the CraterPointsRaw layer.
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Exercise 3C: Tools for modifying and analyzing features

Chapter 3: Working with vector data

Optional: Create a new feature with different geometry

YV V V V V V

Suppose it is preferred that the craters be represented by polylines instead of polygons. There are many tools that
can create new features from existing ones with different geometry, including Feature To Polygon (polylines must
be closed shapes) and Feature To Point (can convert either a polygon or polyline feature class).

Use the Search window to find the Polygon To Line tool and open it.

For Input Features select CraterPolygons.

For Output Feature Class click the browse button and name the file CraterRims.

Uncheck Identify and store polygon neighboring information.

Click OK to run the tool.

Turn off the CraterPolygons layer.

The new CraterRims feature class is a polyline that approximates the rims of the craters.

Optional: Analyze crater distribution

>

Y

Use the Search window to find and open the Average
Nearest Neighbor tool.

For Input Feature Class, select CraterPoints.
Check Generate Report, and then OK to run the tool.

Open the Results window, either by clicking on the pop-up
window in the lower right when the tool finishes or from
Geoprocessing in the top menu.

If necessary, expand the Average Nearest Neighbor
heading at the top of Current Session and double-click on
Report File.

An html file opens showing the results of the analysis. It
has been saved to the folder you are currently working in
(it will not show up in Catalog).

Average Nearest Neighbor Summary

Mearest Neighbor Ratio: 1.028633

z-score: 1.640580 L3
p-value: 0, 100885

]

Significant

{Random)

Critical Value
{z-scare)
<-2.58
*A5E=-1.96
196 --1.65
-1,65 - 1,65
1.65 - 1.96
1.96 - 2.58
»2.58

Significance Level
{p-valuc)
0.01
0.05
0.10
040
0.05
0.01

\ Significant

nmoooom

|

LS

Clustared

Random

Dispersed

random.

Given the z-score of 1.64057971258, the pattern does not appear to be significantly different than

Average Nearest Neighbor Summary

Observed Mean Distance:

8186.4860 Meters

Expected Mean Distance:

7958.6055 Meters

HNearest Neighbor Ratio:

1.028633

Z-SCore:

1.640580

p-value:

0.100885

Dataset Information

Input Feature Class:

CraterPoints

Distance Method:

EUCLIDEAN

Study Area:

227261772603.156464

Selection Set:

False

Results of Average Nearest Neighbor analysis, indicating

that crater positions are randomly distributed
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Chapter 3: Working with vector data

Chapter Summary

In this chapter you have learned the basics of creating, editing, symbolizing, and analyzing vector data. Our end product
is a variety of feature classes representing the craters of the Gusev Crater region that could now be used for further
analysis. You have also seen how attribute tables show you the data behind the displayed map, and how to manipulate
those tables. It is easy to see by comparing the attribute tables of rasters and feature classes how vector data allows
for significantly more data storage in a single file.

If you were merely investigating for potential research, using something like Robbins’ crater data is a good place to
start. However, if you are ready to perform your own analysis for research project, you should make your own data
from scratch using the methods in Exercise 3A. It is time-consuming, but it will ensure that the aspects of the data most
important to your research are included, and you will be using spatial references that are possibly more up-to-date
than those in pre-existing datasets. Though many processes in ArcGIS can be automated for performing large numbers
of repeated operations, either through Model Builder or writing a Python script, things like digitizing features generally
require a “human touch” and need to be done by hand one at a time. If you have invested a lot of time into a dataset,
you should strongly consider sharing it with others in your research group or even in an online forum like ArcGIS
Online, so that others can use your data for their initial investigations and as guidance for doing their own research.
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analysis

Exercise 4A: Converting rasters to vector data

Estimated time: 10 minutes

Exercise 4B: Using overlay to find landing site areas

Estimated time: 30 minutes
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Chapter 4: Criteria analysis

Introduction

In this chapter you will learn how to prepare data for analysis that involves finding candidate objects, locations, or
regions that meet certain criteria through a process of selection and combination. You will be using analysis techniques
on vector data including proximity and overlay analysis. Our goal is to identify potential landing sites in the Gusev
Crater region for a Mars mission that meet the following criteria:

1. Below -1000 m elevation
2. Slopes less than 5 degrees
3. Able to contain a 12 km diameter landing circle

4. Within 10 km of the rim of a small crater (<1.5 km diameter)

Objectives

» Convert raster data into vector data

> Perform overlay analysis using Union and Intersect
» Perform proximity analysis using Buffer

» Select features based on attributes

> Manage polygon features

Terms

> Raster to Polygon
Overlay
Union

Intersect

YV V V V

Buffer
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Chapter 4: Criteria analysis

Exercise 4A: Converting Rasters to Vector Data

Estimated Time: 10 minutes

Step 1: Convert a discrete raster into a polygon feature class
In the Catalog window, add a folder connection to Chapter4 and name it Chapter 4.
Go to the Exercise4a folder and open the GusevCrater4a map.

Make sure the geodatabase in that folder is the default.

Use the Search window to locate and open the Raster To Polygon tool.

For Input raster, navigate to the default geodatabase and select SlopeReclass.

For Output polygon features navigate to the default geodatabase and name the file Slopes.

YV V V V V V VY

Click OK to run the tool.

Layer Properties X

General Source Selection Display Symbology Fields Defintion Query Labels Joins & Relates Time ~ HTML Popup

Show:

Feat Draw quantities using color to show values. | Import...
Categories Fields Classffication
Quantities Value: Igridcode v }: i Cd Lol Value
--Graduatedcolos | 0 @ —/77-—-—-—7-——— @ ] [ == |
Show = | '.Graduated symbols | MNermalization: |none V| Clagses: \—Qassrfy...
- Proportional symbols
“- Dot densty Color Ramp: | Slope ~ I: Color Ramp
Charts
Multiple Attributes Symbol  Range Label
<5 degrees
5-15 degrees Classes
Flip Symbols
Ramp Colors

Properties for Selected Symbol(s)...

Properties for All Symbols...

| [] Show class ranges using feature .
Reverse Sorting

Remove Class(es)

Combine Classes

Format Labels...

Edit Description...

I OK | Cancel | ‘77 §>p|y

The Symbology tab with elements we will be using
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Exercise 4A: Converting rasters to vector data Chapter 4: Criteria analysis

Step 2: Symbolize the polygon feature classes

Double-click on the Slopes layer in the Table of Contents to open the layer properties window.

Go to the Symbology tab.

Select Quantities in the Show table and ensure that it is set to Graduated colors.

Set Value to gridcode.

Set Color Ramp to Slope (turn off Graphic View to see the names of the color ramps).

Change the Labels for each class to match those of the SlopeReclass layer.

Highlight all three classes, right-click anywhere in them, and select Properties for Selected Symbol(s).

Set Outline Color to No Color.

VV V V V YV VY VYV VY

Click OK, then OK again to close the layer properties window.

Table Of Contents
gG8E
B2 & layers
E
.

@ [ Gusev Region Elevation
Value
| High: 2840
-
Low: -2870

© & Gusev Crater Region
ue

—.ri‘;'; 2l

Results of converting Slope raster to a polygon feature class
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Exercise 4A: Converting rasters to vector data Chapter 4: Criteria analysis

Optional: Convert the elevation raster

> Repeat the previous steps for the elevation raster, symbolize it, and set the transparencies of the layers as follows:
Slopes to 40% and Elevation to 60%. This can be done by accessing the Display tab in the layer properties window,
or by clicking on Adjust Transparency &' on the Effects toolbar.

Table Of Contents. & x

8o 8|
2 5 Layers
B M Elevation

gridcode
171 <1000m
>-1000m
© @ Slopes
gridcode
1 <5 degrees
5-15 degrees
I 515 degrees
© @ ElevationReclass
CI<-1000m
[E>-1000m
B @ SlopeReclass
[ <5 degrees
[15-15 degrees
[>15 degrees
© [ Gusev Region Slope

Value
] High': 340253
|
Low:0
© O Gusev Region Elevation
Value
|4 High: 2840
=]

“Low: -2870

© @ Gusev Crater Region
Value

I High: 255

Low: 1

laelzn < ' = ~

Results of converting Elevation raster to a polygon feature class
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Exercise 4B: Using overlay to find landing site areas

Estimated Time: 30 minutes

Step 1: Merge feature classes using Union

>
>
>

YV V VYV V

>

Go to the Exercise4b folder and open the GusevCrater4db map document.

Make sure the geodatabase there is the default.

From the Geoprocessing in the top menu, select Union.

Notice how a few commonly used tools are quickly available from this menu.

For Input Features, choose Elevation, and then also choose Slopes.

For Output Feature Class, navigate to the default geodatabase and name the file ElevationSlopesUnion.
Click OK to run the tool.

Open the attribute table for the ElevationSlopesUnion layer.

There are now more polygons than in either of the original feature classes, subdivided by their combination of
attributes from both layers into polygons that now each have all the attributes from the original features. This is
because areas of overlap between the two feature classes form new polygons with attributes from both feature
classes and areas with no overlap also form new polygons, resulting in an increase in the number of polygons. This
ensures that each new polygon has all the attributes from the original features.

Close the attribute table.

Step 2: Select potential landing areas

>
>

A\

From Selection in the top menu, choose Select By Attributes.

We want the lowest slope and elevation, so we only want values of 1 for each of these fields. Select
ElevationSlopesUnion layer and build the following query:

gridcode =1 AND gridcode_1 =1
Click OK.

Open the attribute table for the union layer to see which polygons are selected and how many have been selected
(790 out of 5771).

Close the attribute table.
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Table OF Contents 2 x
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Selection of areas that are both below —1000m elevation and have slopes less than 5 degrees

Step 3: Create a feature class from the layer selection

We want to create a new feature class with only these selected features.

Right-click on the newest layer and from Data choose Export Data.

For Export select Selected features.

For coordinate system, select the data frame.

For Output feature class, navigate to the default geodatabase and name the file PotentialLandingAreas.
Click Save and then OK to complete the export.

Click Yes to add the new feature to the map.

Click Clear Selected Features [l on the Tools toolbar.

YV V V V V VYV VYV VY

Turn the ElevationSlopesUnion layer off.

Step 4: Symbolize and explore the results

> Click on the symbol for the PotentialLandingAreas layer in the Table of Contents.

> In the Search box at the top of the Symbol Selector window, type overlay and hit enter.

> Click on 100 Year Flood Overlay.

> Change the outline color to Indicolite Green (row 1, column 8), and change outline width to 2.

> Click OK to close the Symbol Selector window and set the transparency of the layer to 30%.

This can be done by accessing the Display tab in the layer properties window, or by clicking on Adjust
Transparency £ on the Effects toolbar.
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Exercise 4B: Using overlay to find landing site areas

>
>

Turn off the Elevation layer and the Slopes layer.

Turn on the Gusev Region Slope layer and the Gusev Region Elevation layer.

Their color ramps are the same and their transparencies are set to allow both to be visible.

Chapter 4: Criteria analysis

Pan and zoom around to notice how the PotentialLandingAreas tends to cover greener areas where both the

elevation and slopes are low.
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Results of isolating regions suitable in both elevation and slope

Optional: Find potential landing sites by finding large enough contiguous areas

YV V V V V

Y VYV

YV V V V

First we will eliminate areas that are not large enough to fit a 12 km diameter landing circle.

Turn off the Gusev Region Slope and the Gusev Region Elevation layers.

From the Geoprocessing in the top menu, select Buffer.

For Input Features, choose PotentialLandingAreas.

For Output Feature Class, navigate to the default geodatabase and name the file PotentialLandingNegBuff.

Select Kilometers for Linear Unit and enter -6.

This will eliminate any polygons that are not large enough to accommodate a 6 km radius landing circle.
We want to dissolve the result into one polygon, so set Dissolve Type to ALL.

Click OK to run the tool.

Then we will create regions for potential landing sites.

From the Geoprocessing in the top menu, select Buffer again.

For Input Features, choose PotentialLandingNegBuff.

For Output Feature Class, navigate to the default geodatabase and name the file PotentialLandingPosBuff.

Set the buffer distance to 6 Kilometers.
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Reduction to areas large enough to accommodate a 12 km diameter landing circle

Click OK to run the tool.

Now, we want to split the one resulting disjointed polygon into multiple contiguous ones. Use the Search window
to find the Multipart to Singlepart tool and open it.

For Input Features, choose PotentialLandingPosBuff.
For Output Feature Class, navigate to the default geodatabase and name the file PotentialLandingSites.
Click OK to run the tool.

Open the attribute table for PotentialLandingSites.
Notice there are now 25 polygons.

Remove the buffered layers from the map document in the Table Of Contents by right-clicking on the name and
selecting Remove (this does not delete those feature classes).

Turn off the PotentialLandingAreas layer by unchecking the box next to its name.

Symbolize this map however you like.

Optional: Use crater data to further refine landing site selections

On your own, bring in data from our crater analysis in Chapter 3 and use the Buffer and Intersect tools to find suitable
landing sites within the PotentialLandingSites that are within 10 km of a small crater rim (less than 1.5 km diameter).
Since this additional criteria will shrink the areas that are potential landing sites, you will need to repeat steps 4 and 5
after doing the intersection to again eliminate any areas that are too small for the landing circle to fit.
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Chapter 4: Criteria analysis

Chapter Summary

In this chapter you learned how to combine raster and vector data to perform analysis based on specific criteria. You
converted rasters into vectors so that you could use vector analysis tools, but it is also possible to convert vectors into
rasters and use raster analysis tools, though this usually only works well with two-dimensional vectors, i.e. polygon
feature classes. Raster Calculator is a general overlay tool that is used to combine data from multiple rasters. It is best
to carefully plan out the steps you will take to perform your analysis ahead of time, since there are usually multiple
ways to obtain the same results and you must decide which is most efficient for your purposes. For instance, we could
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have created new layers through selection for each of the elevation and slope layers that would only contain the
lowest ranges, and then used the Intersect tool to create polygons that fit both requirements. Instead, we first used
Union and then a single selection from the resulting layer, which for this exercise was quicker and easier.

For an analysis process that you plan on repeating, the Model Builder function in ArcMap can be used to create a
pipeline of tools and outputs to essentially create a new tool that you design. This model can then be saved as a single
tool. A similar process can be done with rasters from the Image Analysis window by clicking on the Add Function
Template to open the Function Template Editor.
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products

Exercise 5A: Working in Layout View
Estimated time: 10 minutes
Exercise 5B: Creating a map product

Estimated time: 15 minutes
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Chapter 5: Creating map products

Introduction

In this chapter you will learn how to prepare a finalized map product that is suitable for publishing or sharing online.
This is done in ArcMap using the Layout View mode, as opposed to the Data View mode you have been working in
while doing analysis and interpretation. Polished map products should have a title, legends, scale bards, and north
arrows, which ArcMap refers to as map elements. Elements such as these, that are not spatially related to the data
frame are only accessible while in Layout View. Text labels and other elements that are associated with specific loca-
tions in the data frame can be added and edited in either Data View or Layout View. Also, while only the active data
frame can be viewed in Data View, multiple data frames can be viewed and worked on in Layout View so that a map
product can have multiple data frames on it. However, as with Data View, only the active data frame can be worked
on while in Layout View.

Objectives

> Explore the difference between Data View and Layout View
> Become familiar with the Layout toolbar

» Add basic map elements

»  Work with multiple data frames

Terms

> Data View
> Layout View
» Map Element

> Extent Rectangle
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Chapter 5: Creating map products

Exercise 5A: Working in Layout View

Estimated Time: 10 minutes

Step 1: Viewing a map in Layout Mode

>
>
>

In the Catalog window, add a folder connection to Chapter5 and name it Chapter 5.
Go to the Exercise5a folder and open the GusevRegionLandingSiteAnalysis map.

In the lower left corner of the map display, change Data View [Z] to Layout View [ .

Notice the Layout toolbar automatically appears if you do not have it already open or docked somewhere. Layout
View is where you can combine data frames and add titles, legends, scale bars, etc., to create a publishable map.
Changes in the Table of Contents will still have the same effects on the appearance of the layers in the data
frames. Try turning some layers on and off to see this.

Step 2: Differences between the Layout toolbar and the Tools toolbar

>

>

>

Explore the map layout using the Zoom In &, Zoom Out = and Pan {7 tools in the Layout toolbar.
These tools treat the display as a single page.
Explore the Landing Sites data frame using the Pan &' , Zoom In ®, and Zoom Out =, tools on the Tools toolbar.

Using these tools will only affect the active data frame. If you wanted to make changes to the Slope & Elevation
data frame, you would need to activate it first. This can be done by either right-clicking on the data frame and
selecting Activate, or by holding down the Alt key while left-clicking on the data frame.

Click Zoom Full Page % on the Layout toolbar.

Step 3: Map elements

>
>

Y

Change back to Data View, and click Insert from the top menu.

Notice how options such as Title, Legend, and Scale Bar are not available, but Text, Picture, and Object are. This is
because the location of things like titles and legends are stylistic, whereas things like text labels of a particular
feature are location specific.

Switch back to Layout Mode.

Click Insert again, and notice these options are now available.

In the next exercise, you will learn how to create and modify map elements.
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Exercise 5B: Creating a map product

Estimated Time: 15 minutes

Step 1: Getting started in Layout View
> Go to the Exercise5b folder and open the GusevCrater5b map.

> Inthe lower left corner of the map display, change Data View to Layout View.

The three data frames are all in the middle of the page, each with a thin, black rectangle around them. The rectan-
gles show the extent of the data frame on the page, and mimics the extent of the map display window when in Da-
ta View.

> Click the Pan tool on the Tools toolbar and use it to move the Landing Sites data frame around.

Notice how if you move the map display outside of its extent rectangle, it is no longer visible.

Step 2: Arranging data frames
> Activate the Craters data frame.
> Select the Pan tool.

» Click and drag the Craters map display and, without letting go of the left mouse button, try to move the map dis-
play to the upper right corner and then move it back to the center before releasing the left mouse button.

The map display disappeared because it was moved outside the data frame’s extent rectangle.
> Click on Select Elements on the Tools toolbar, and then click on the Craters map display.

The rectangle around the Craters map display is now highlighted and when you move the cursor over it a four-
sided arrow appears.

Y

Click and drag the Craters data frame to the upper right corner of the page.
> Use Pan and Zoom on the Tools toolbar to get the map display to fill the data frame’s extent rectangle.
Select Elements can also be used to resize the extent rectangle.

> Repeat these steps to move the Slope & Elevation data frame to the lower right corner, and then move the Land-
ing Sites map display to the upper left, leaving some room on top for a title. Do not resize the Landing Sites extent
rectangle, but rather use it as a frame around your entire map product.

Note that when you select a data frame’s extent rectangle, it is automatically activated. However, unlike the Pan
and Zoom tools, you can resize and move a data frame’s extent rectangle without needing to have that data frame
active.

Step 3: Adding basic map elements
> Click Insert from the top menu bar and select Title.

> Name the map Gusev Region Landing Site Analysis and click OK.

The newly created map element is automatically selected.
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>

YV V. V V V YV V V VY YV V V VY

YV V V V V

Right-click on the title and select Properties.

Click Change Symbol.

Change the Size to 20 and click on the bold symbol for Style.
Click OK, and then OK again.

Use Select Elements to move the title to the upper left corner of the page, just above the Landing Sites map dis-
play and inside that data frame’s extent rectangle.

It if is not, make the Landing Sites data frame active.
From the Insert menu, select Scale Bar.
Click on Alternating Scale Bar 2 and then click OK.

Move the scale bar just below the Landing Sites map display.

The scale bar created will be based on spatial data from the active data frame and will automatically adjust to any
changes in how that data frame is being displayed, such as zooming in or out.

Right-click on the scale bar and select Properties.

Change Division Units to Kilometers and click OK.

From the Insert menu select Legend.

Click on GusevBasemap under Legend Items and then click the left arrow (<).

Then click Next.

This is how you can specify which layers you want to be shown in your legend.
Delete Legend from the Legend Title field and leave it blank, then click Next.
Continue clicking Next, observing all the options available at each step.

Click Finish at the end.

Adjust the position and size of the legend to fit right below the scale bar.

Repeat the previous seven steps to create legends for the other two data frames, remembering to activate the
frame before selecting Legend from the Insert menu.

Your map product should now look similar to the one seen in Exercise 5A.

Chapter Summary

In this chapter you learned the basics of working in Layout View, arranging multiple data frames within a map product,

and adding map elements. You also saw that there are many more options available for creating map products suitable

for publishing. Working with data frames and map elements in Layout View works similarly to a program like MS Pow-

erPoint. The finished map can be exported in several formats. If you click on File in the top menu and hover your cursor
over Export Map, you will see the options available for doing this.
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Appendix: Common File Types

Common File Types

*  Data frame =
*  Contains one or more layers, part of the map document structure

*  Only one data frame can be active at a time, can activate by right-clicking menu of the data frame or by Alt-
left-clicking on the data frame

*  Only the active data frame can be viewed in Data View; in Layout View, only the active data frame can be
altered

* Feature Class [>) =) &

*  Similar to shapefile, but with additional files for use in ArcGIS

*  Can ONLY be used within an ArcGIS geodatabase, can be exported as a shapefile
x  Feature Dataset 7

*  Contains multiple feature classes related by content, must have the same coordinate system
* Geodatabase: *gdb (3 (default geodatabase: (& )

*  ArcGlIS file structure for storing, organizing, and sharing data with other ArcGIS users
* |Image Files: *tif &

*  Common: TIFF (regular or GeoTIFF), JPEG, JPG2, PNG, BMP, GIF, etc.

*  Dataset specific: SAR, SRTM, DEM, DOQ, LAS, many more
*  Layer: *.lyr &

*  Store information for how to display a particular data source or dataset

*  Does NOT store any source data
*  Map Document: *.mxd @]

*  Stores information for how to display all data in a map

*  Does NOT store any source data
* Packages: *.Ipk &, *.mpk i

*  Stores both display instructions and source data

*  Good for sharing with other ArcGIS users who do not have access to your geodatabase
x  Shapefile: *.shp = = @

*  Stores spatial and geometric data for features

*  Used by most GIS software , can be used in ArcGIS but not within a geodatabase, can be imported as a fea-
ture class

x  Table ]

*  Tabular data, can be imported from other formats like MS Excel and then added to the attribute table of a
feature class, or can be exported from the attribute table data of a feature class
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Toolbars
The Standard toolbar
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Glossary

*  Attribute Table: a table that stores non-spatial information about features in a feature class (or statistics on pixel
values in a raster), more columns can be added to associate additional data with features (only for feature classes,
not rasters)

*  Average Nearest Neighbor: a tool that calculates the nearest neighbor index from the average distance between
each feature and its next neighboring feature

* Basemap: a raster depicting background reference information onto which other layers, either from rasters or fea-
ture classes, are placed

*  Buffer: a tool for creating a zone around a map feature a specified distance from the edge of the feature, output is
a polygon feature class, distance can be negative to create a smaller zone within a feature (not available in earlier
versions of ArcGIS Desktop)

*  Cell Size: the spatial resolution of a raster, i.e. the physical size of a pixel on the surface being viewed
*  Construction Tools: specifies the method by which the user will draw a new feature

* Data Frame: a map element that contains one or more layers, all layers in a data frame share a geographic extent
and coordinate system, a map may contain multiple data frames but only one frame may be active at a time and
only the active frame will be visible in Data View mode in ArcMap

* Data View: one of two possible modes for displaying maps in ArcMap, used during analysis and interpretation, cer-
tain map elements with no spatial relationship to the data frame (such as legends, titles, scale bars, etc.) are not
shown in this mode and are only visible in Layout View, text labels and other objects associated with specific loca-
tions on the map are shown in Data View

*  Edit Session: while in an edit session, changes to features and attributes that alter source data can be made and
new features can be created

*  Editor Toolbar: contains tools used to start and stop editing sessions and edit data during an editing session

* Feature Class: a vector data file used specifically by ArcGIS to store geometric features and attributes associated
with them, analogous to shapefiles used thoughout GIS platforms but with added features for use with ArcGIS tools

*  Feature Dataset: a collection of feature classes stored together that share the same coordinate systems, extent
area, and theme; feature classes with different geometries can be stores in the dame dataset

*  Fields: the columns in an attribute table which associate a value for a certain property, or other type of information
such as a word, thumbnail image, or hyperlink, for all the features in a feature class or shapefile

* Geodatabase: contains a file structure for organizing data such as feature classes, rasters, and tables; the structure
can only be properly viewed within ArcCatalog, as its schema and file types are not recognized by other data view-
ers such as Windows Explorer or Mac Finder

*  Hillshade: a feature that uses elevation data from a raster to simulate the terrain with shadows due to a light
source

* Hot Spot Analysis: a tool used to visualize statistically significant spatial clusters of high values (hot spots) and low
values (cold spots) of a given numerical attribute within a feature class

* Intersect: a tool for creating a new feature class from two or more existing polygon feature classes, which creates
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polygon features based on the areas where features in the existing feature classes overlap; attributes from all input
features are included in the attribute table of the output feature class’ attribute table

Layer: on a map; layers can also define additional properties, such as which features from the data source are in-
cluded a component of a map document that provides information on how to display data from a given source file;
can be stored as a file and used to display other similar source files; layers appear in the Table of Contents window
in ArcMap

Layout View: one of two possible modes for displaying maps in ArcMap, used after analysis is complete for creating
a finished map product for publication; in this mode map elements can be created and modified, such as titles, leg-
ends, and scale bars and data frames can be moved and resized on the page; all data frames are visible, but as with
Data View only the active frame can be manipulated

Map Document: a file that contains information for how to display spatial data, such as feature classes and rasters;
contains one or more data frames, each of which contain one or more layer; contains no source data, and must be
saved as a Map Package in order to include source data in the file

Metadata: information associated with a data file, such as source, authors/owners, keywords, coordinates, and
previous processing; can be edited by any user in ArcCatalog

Overlay: a set of processing tools, such as Intersect and Union, that create new feature classes from the overlap-
ping of existing features

Query: a logic expression that describes a subset of features within a feature class by their properties; typically
used to select features that make the expression true

Raster to Polygon: a tool that converts a raster to a polygon feature class by converting areas of equal cell value
into polygon features

Raster: an array of cells (pixels) each possessing a numerical value and a spatial coordinate; image files of all com-
mon types can be loaded in ArcMap and spatial data can be added through georeferencing to existing rasters cov-
ering the same geographic area

Selection: a subset of features from a feature class isolated for analysis, often created by using a query but also can
be created by hand using the Select Features tool on the Tools toolbar

Snapping: an adjustable feature of editing that allows for exact matching of position to an existing part of a fea-
ture, such as a vertex or edge, when the mouse is moved to within a specified distance, or tolerance, of the object

Spatial Analyst Toolbar: provides advanced analysis tools for use on both rasters and vector data

Streaming: a feature used in digitizing (drawing by hand) polylines and polygons in which vertices are added auto-
matically at regular defined intervals as the mouse is moved

Symbology: controls how the data are displayed in ArcMap, such as color, icon size, line width, continuous vs. dis-
crete, etc.; symbology information is stored in layer files and map documents

Union: a tool for creating a new feature class from two or more existing polygon feature classes, which creates pol-
ygon features based on the areas occupied by any features in the existing feature classes; attributes from all input
features are included in the attribute table of the output feature class’ attribute table

Vector: a geometric object, such as a point, line, or polygon, defined by the exact locations and sizes of defining
properties, such as end points and lengths; as vectors do not depend on arrays of cells, but rather by pure geome-
try, they have effectively infinite resolution when being displayed
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